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Introduction  
The BlueNRG-1 is a low power Bluetooth® smart system on chip, compliant with the Bluetooth® v4.2 
specification and supporting master, slave and simultaneous master-and-slave roles. 

The following BlueNRG-1 kits are available: 

1. BlueNRG-1 development platform (order code: STEVAL-IDB007V1) 

The STEVAL-IDB007V1 also provides a set of hardware resources for a wide range of application 
scenarios: sensor data (accelerometer, pressure and temperature sensor), remote control (buttons and 
LEDs) and debug message management through USB virtual COM. Three power options are available 
(USB only, battery only and external power supply plus USB) for high application development and 
testing flexibility. 

Figure 1: STEVAL-IDB007V1 development platform 
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1 Getting started 

1.1 Kit contents 

The STEVAL-IDB007V1 kit includes: 

 1 BlueNRG-1 development platform 

 1 2.4 GHz Bluetooth antenna 

 1 USB cable 

1.2 System requirements  

The BlueNRG-1 Navigator and Flasher PC applications require: 

 PC with Intel® or AMD® processor running one of the following Microsoft® operating 
systems: 

 Windows XP SP3 

 Windows Vista 

 Windows 7 

 At least 128 MB of RAM 

 USB ports 

 At least 40 MB of available hard disk space 

 Adobe Acrobat Reader 6.0 or later. 

1.3 BlueNRG-1 development kit setup 

After downloading the BlueNRG-1 DK software package (STSW-BLUENRG1-DK) from 
www.st.com, extract BlueNRG-1_DK-x.x.x-Setup.zip contents to a temporary directory, 
launch BlueNRG-1-DK-x.x.x-Setup.exe and follow the on-screen instructions. 
 

 

EWARM Compiler 7.70 or later is required for building the BlueNRG1_DK_x.x.x 
demonstration applications. 

 

 

 

Keil MDK-ARM and Atollic-True Studio toolchains are also supported. 

 

http://www.st.com/
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2 Hardware description 

2.1 STEVAL-IDB007V1 board overview 

The BlueNRG-1 board in the STEVAL-IDB007V1 development kit lets you experiment with 
BlueNRG-1 system on chip functions. It features: 

 Bluetooth® SMART board based on the BlueNRG-1 Bluetooth low energy system on 
chip 

 Associated BlueNRG-1 development kit SW package including firmware and 
documentation 

 Up to +8 dBm available output power (at antenna connector) 

 Excellent receiver sensitivity (-88 dBm) 

 Very low power consumption: 7.7 mA RX and 8.3 mA TX at -2 dBm  

 Bluetooth® low energy v4.2 compliant, supports master, slave and simultaneous 
master-and-slave roles 

 Integrated balun which integrates a matching network and harmonics filter 

 SMA connector for antenna or measuring equipment 

 3 user LEDs 

 2 user buttons 

 3D digital accelerometer and 3D digital gyroscope 

 MEMS pressure sensor with embedded temperature sensor 

 Battery holder 

 JTAG debug connector 

 USB to serial bridge for providing I/O channel with the BlueNRG-1 device 

 Jumper for measuring current for BlueNRG-1 only 

 RoHS compliant 

The following figure and table describe physical sections of the board. 

Figure 2: STEVAL-IDB007V1 board components 
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Table 1: STEVAL-IDB007V1 board component descriptions 

Region Description 

A BlueNRG-1 system on chip 

C Micro USB connector for power supply and I/O 

O JTAG connector 

M RESET button 

N two USER buttons 

H LPS25HB MEMS pressure sensor with embedded temperature 

I LSM6DS3 3D digital accelerometer and 3D digital gyroscope 

G PWR LED  

P three user LEDs 

back of the 
PCB 

battery holder for two AAA batteries 

J, L Two rows of Arduino-compliant connectors 

S Integrated balun with matching network and harmonics filter 

Q 
STM32L151CBU6 48-pin microcontroller (USB to serial bridge for I/O channel to 
PC communication)(1) 

R ST2378E level translator to adapt voltage level between STM32 and BlueNRG-1 
 

Notes: 
(1)STM32 is not intended to be programmed by users 

 

2.2 BlueNRG-1 SoC connections 

The BlueNRG-1 very low power Bluetooth low energy (BLE) single-mode system on chip 
(Figure 2: "STEVAL-IDB007V1 board components" – region A) has 160 KB of Flash, 24 KB 
of RAM, a 32-bit core ARM cortex-M0 processor and several peripherals (ADC, GPIOs, 
I²C, SPI, Timers, UART, WDG and RTC). 

The microcontroller is connected to various components such as buttons, LEDs and 
sensors. The following table describes the microcontroller pin functions. 

Table 2: BlueNRG-1 pin description with board functions 

Pin name 
Pin 
No 

Board function 

LED Micro Button 
Pressure 
sensor 

3D 
accelerometer 
and 
gyroscope 

JTAG 

Arduino connectors 

CN1 CN2 CN3 CN4 

DIO10 1      JTMS-
SWTDIO 

    

DIO9 2      JTCK-
SWTCK 

    

DIO8 3  TXD 
(PA2) 

    pin 1 

IO8 
 

pin 
2 

TX 
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Pin name 
Pin 
No 

Board function 

LED Micro Button 
Pressure 
sensor 

3D 
accelerometer 
and 
gyroscope 

JTAG 

Arduino connectors 

CN1 CN2 CN3 CN4 

DIO7 4 DL2      pin 2 

IO9 
  

pin 
6 

SCL 

DIO6 5 DL1        
pin 
7 

IO6 

pin 
5 

SDA 

VBAT3 6           

DIO5 7    
SDA 

PUSH2 
button 

  pin 9 

SDA 
   

DIO4 8    SCL   
pin 
10 

SCL 

   

DIO3 9     SDO/SA0  pin 5 

MISO 
 

pin 
6 

IO5 

 

DIO2 10     SDA  pin 4 

MOSI 
 

pin 
5 

IO4 

 

DIO1 11     CS 
JTAG-
TDO 

pin 3 

CS 
   

DIO0 12     SCL 
JTAG-
TDI 

pin 6 

SCK 
 

pin 
4 

IO3 

 

ANATEST0/DIO14 13 DL3         
pin 
4 

AD3 

ANATEST1 14           

ANATEST2 15           

ANATEST3 16           

FXTAL1 17           

FXTAL0 18           

VBAT2 19           

RF1 20           

RF0 21           

SXTAL1 22           

SXTAL0 23           

VBAT1 24           

RESET 25  RESET RESET   RESET  pin 3 

NRST 

pin 
8 

IO7 

 

SMPSFILT1 26           

SMPSFILT2 27           
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Pin name 
Pin 
No 

Board function 

LED Micro Button 
Pressure 
sensor 

3D 
accelerometer 
and 
gyroscope 

JTAG 

Arduino connectors 

CN1 CN2 CN3 CN4 

VDD1V2 28           

DIO13 29   PUSH1       
pin 
3 

AD2 

DIO12 30     INT1     
pin 
1 

AD0 

FTEST 31           

DIO11 32  RXD 

PA3 
      

pin 
1 

RX 

pin 
3 

IO2 

pin 
2 

AD1 

 

The board section labeled BLUENRG-1 (Figure 2: "STEVAL-IDB007V1 board components" 
– region B) includes the following main components: 

 BlueNRG-1 low power system on chip (in a QFN32 package) 

 High frequency 16 MHz crystal 

 Low frequency 32 kHz crystal for the lowest power consumption 

 Integrated balun which integrates a matching network and harmonics filter 

 SMA connector 

For more details, see Figure 24: "STEVAL-IDB007V1 BlueNRG-1" 

2.3 Power supply 

Green LED DL4 (Figure 2: "STEVAL-IDB007V1 board components" – region G) signals the 
board is being powered, either via: 

 micro USB connector CN5 (Figure 2: "STEVAL-IDB007V1 board components" – 
region C) 

 two AAA batteries (region F) 

 an external DC power supply plus micro USB connector 

The following table describes the power supply modes available on the STEVAL-IDB007V1 
board and corresponding jumper settings. 

Table 3: STEVAL-IDB007V1 kit platform power supply modes 

Power 
supply mode 

JP1 JP2 Comment 

1 - USB 
Fitted: 
1-2 

Fitted: 2-
3 

USB supply through connector CN5 (Figure 2: "STEVAL-
IDB007V1 board components" – region C) 

2 - Battery 
Fitted: 
2-3 

Fitted: 1-
2 

The supply voltage must be provided through battery pins 
(region F). 

3 - Combo 
Fitted: 
1-2 

Optional 
USB supply through connector CN5 for STM32L1; JP2 
pin 2 external power for BlueNRG-1 
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2.4 Jumpers  

The following jumpers are available: 

Table 4: STEVAL-IDB007V1 kit platform jumpers 

Jumper Description 

JP1  
1-2: to provide power from USB (JP2: 2-3) 

2-3: to provide power from battery holder (JP2: 1-2)  

JP2 

1-2: to provide power from battery holder (JP1: 2-3) 

2-3: to provide power from USB (JP1: 1-2) 

JP2 pin 2 to VDD to provide external power supply to BlueNRG-1 (JP1: 1-2) 

JP3 
pin 1 and 2 UART RX and TX of MCU 

pin 3 GND 

JP4 Fitted: to provide VBLUE to BlueNRG-1. It can be used also for current measurement. 

JP5 
Fitted: TEST pin to VBLUE  

Not fitted: TEST pin to GND  

 

2.5 Sensors  

The following sensors are available on the platform: 

1. An LPS25HB (Figure 2: "STEVAL-IDB007V1 board components" – region H) is a 
piezoresistive absolute pressure sensor which functions as a digital output barometer. 
The device comprises a sensing element and an IC interface which communicates 
through I²C from the sensing element to the application. 

2. An LSM6DS3 3D (region I) digital accelerometer and 3D digital gyroscope with 
embedded temperature sensor which communicates via SPI interface. One line for 
interrupt is also connected. 

2.6 Extension connector  

BlueNRG-1 signal test points are shared on two Arduino-compliant connector rows: CN1, 
CN3 (Figure 2: "STEVAL-IDB007V1 board components" – region J) and CN2, CN4 (region 
L). See Table 2: "BlueNRG-1 pin description with board functions". 

2.7 Push-buttons  

The board has one user button to reset the microcontroller (Figure 2: "STEVAL-IDB007V1 
board components" – region M) and two further buttons for application purposes (region N). 

2.8 JTAG connector 

A JTAG connector (Figure 2: "STEVAL-IDB007V1 board components" – region O) allows 
BlueNRG-1 microcontroller programming and debugging with an in-circuit debugger and 
programmer such as ST-LINK/V2. 
 

 

Only SWD mode is supported 
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2.9 LEDs  

LEDs DL1 (yellow), DL2 (red), DL3 (blue) and DL4 (green, power LED) are available on the 
board (Figure 2: "STEVAL-IDB007V1 board components" – regions G and P). 

2.10 STM32L151CBU6 microcontroller  

The most important feature of the STM32L151CBU6 48-pin microcontroller (Figure 2: 
"STEVAL-IDB007V1 board components" – regions Q) is the USB to serial bridge providing 
an I/O channel with the BlueNRG-1 device. 

The microcontroller is connected to the BlueNRG-1 device through an ST2378E level 
translator (region R). 
 

 

The STM32L microcontroller on the board is not intended to be programmed by 
users. ST provides a pre-programmed firmware image for the sole purpose of 
interfacing BlueNRG-1 to a USB host device (e.g., a PC). 

 

2.11 Current measurements  

To monitor the power consumption of the BlueNRG-1 only, remove the jumper from JP4 
and insert an ammeter between pins 1 and 2 of the connector (when the power is ON, 
remove the USB connection). 

Since power consumption of the BlueNRG-1is usually very low, an accurate instrument in 
the range of few micro amps is recommended.  

2.12 Hardware setup 

1. Connect an antenna to the SMA connector 
2. Configure the board to USB power supply mode as per the jumper settings in Table 3: 

"STEVAL-IDB007V1 kit platform power supply modes" 
3. Connect the board to a PC via USB cable (connector CN5) 
4. Verify the power indication LED DL4 is on. 
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3 BlueNRG-1 Navigator  
BlueNRG-1 Navigator is a user friendly GUI which lets you select and run demonstration 
applications easily, without requiring any extra hardware. With it, you can access the 
following BlueNRG-1 DK software package components: 

 BlueNRG-1 Bluetooth low energy (BLE) demonstration applications 

 BlueNRG-1 peripheral driver examples 

 BlueNRG-1 development kits 

 release notes 

 license files 

With BlueNRG-1 DK Navigator, you can directly download and run the selected prebuilt 
application binary image (BLE examples or peripheral driver example) on the BlueNRG-1 
platform without a JTAG interface. 

The interface gives demo descriptions and access to board configurations and source code 
if needed. 

You can run the utility through the BlueNRG-1 Navigator icon under: Start → 
STMicroelectronics → BlueNRG -1 DK X.X.X → BlueNRG-1 Navigator 

Figure 3: BlueNRG-1 Navigator 

 

 

3.1 BlueNRG-1 Navigator ‘Demonstration Applications’  
You can navigate the menus for the reference/demo application you want to launch. For 
each application, the following information is provided: 

 Application settings (if applicable) 

 Application description 

 Application hardware related information (e.g., LED signals, jumper configurations, 
etc.) 

The following functions are also available for each application: 

 Flash: to automatically download and run the available prebuilt binary file to a 
BlueNRG-1 platform connected to a PC USB port. 
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 Doc: to display application documentation (html format) 

 Project: to open the project folder with application headers, source and project files. 

The figure below shows you how to run the BLE Beacon demo application; the other 
demos function similarly. 

Figure 4: BLE Beacon application 

 

 

When a BlueNRG-1 platform is connected to your PC USB port, you can press the “Flash & 
Run” tab on the selected application window to download and run the available prebuilt 
application binary image on the BlueNRG-1 platform. 

Figure 5: BLE Beacon Flash programming 

 

 

Selecting the “Doc” tab opens the relative html documentation. 
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Figure 6: BLE Beacon documentation 

 

 

3.1.1 BlueNRG-1 Navigator ‘Basic examples’  
This page lists some basic sample applications for the BlueNRG-1 device to verify that 
BlueNRG-1 device is alive as well as the device sleep and wakeup modes. 

Figure 7: Basic examples 

 

 

3.1.2 BlueNRG-1 Navigator ‘BLE demonstration and test applications’ 
This page lists all the available Bluetooth low energy (BLE) demonstration applications in 
the BlueNRG-1 DK software package. These applications provide usage examples of the 
BLE stack features for the BlueNRG-1 device. 
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Figure 8: BLE demonstration and test applications 

 

 

3.1.3 BlueNRG-1 Navigator ‘Peripherals driver examples’  
This page lists the available BlueNRG-1 peripherals and corresponding test applications to 
work with certain features specific to the selected BlueNRG-1 peripheral. 

Figure 9: Peripherals driver examples 

 

 

3.2 BlueNRG-1 Navigator ‘Development Kits’ 
This window displays the available BlueNRG-1 DK Kit platforms and corresponding 
resources. When you hovers the mouse pointer over a specific item, the related component 
is highlighted on the board. 
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Figure 10: STEVAL-IDB007V1 Kit components 

 

 

3.2.1 BlueNRG-1 Navigator ‘Release Notes’ and ‘License’  
As their name suggests, these pages display the BlueNRG-1 DK SW package Release 
Notes (html format) and the BlueNRG-1 DK software package license file, respectively. 
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4 BlueNRG-1 Flasher utility 
The BlueNRG-1 Flasher utility allows BlueNRG-1 programming using the UART 
bootloader. 

4.1 System requirements and installation  

The BlueNRG-1 Flasher utility PC configuration requires the following minimum 
characteristics 

 A PC with USB port running Windows® XP or Windows® 7 

 256 MB RAM 

 30 MB free hard disk space 

You can run this utility by clicking on the BlueNRG-1 Flasher icon under: Start → 
STMicroelectronics → BlueNRG -1 DK X.X.X → BlueNRG1 Flasher 

Figure 11: BlueNRG-1 Flasher utility 

 

 

4.2 Main user interface window  

In the upper section of the BlueNRG-1 Flasher – Utility main window, you can: 

 select the image file (‘Select file’ button) 
 choose the flashing address (‘Flash from’ text input bar, only enabled for .bin files) 

 select the COM port to be used to interface the device (‘Port’ dropdown list) 



BlueNRG-1 Flasher utility UM2071 
 

20/56 DocID029370 Rev 3  
 

The BlueNRG-1 device memory is read when the associated COM port is opened. 

Figure 12: BlueNRG-1 Flasher utility main window 

 

 

4.2.1 Main menu items  

From the ‘File’ menu, you can: 

 Load an existing .bin or .hex (Intel extended) file. 

 Save the current memory image in a .bin file. The start address and the size of the 
memory section to be saved to file are selectable from the ‘Device Memory’ tab. 

 Close the application. 

From the ‘Tools’ menu, you can mass erase all the device Flash memory. 

4.2.2 Image file selection  

Use the ‘Select file’ button on the main page (or the File>Load menu) to load an existing 
.bin or .hex file. The full path of the selected file appears next to the button and the ‘Flash’ 
becomes active. 
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Figure 13: BlueNRG-1 Flasher utility file selection 

 

 

By default, the ‘Mass erase’ option beside the ‘Flash’ button is not checked, and only the 
required memory pages are erased and written with the file content. When this option is 
checked, the memory flash phase is preceded by a full mass erase. 

The ‘Verify’ option forces a check to ensure that the memory content has been written 
correctly. 

Check the ‘Update memory table’ option to update the ‘Device Memory’ table after the 
flashing operation. This option is automatically checked when the ‘Verify’ checkbox is 
selected. 

4.2.3 ‘Image File’ tab  
The selected file name, size and parsed contents to be flashed to device memory can be 
viewed in the ‘Image File’ tab. 

Figure 14: BlueNRG-1 Flasher utility image file viewer 

 

 

4.2.4 ‘Device Memory’ tab  
Select this tab to view the memory contents of a connected device. 
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Figure 15: BlueNRG-1 Flasher utility device memory viewer 

 

 

Click the ‘Read’ button to transfer the memory segment defined by ‘Start Address and 
‘Size’ into the table. 

The first column gives the base address of the following 16 bytes in a row (e.g., row 
0x10040050, column 4 holds the hexadecimal byte value at 0x10040054. 

You can change byte values by double-clicking a cell and entering a new hexadecimal 
value; edited bytes appear in red. 

Click the ‘Write’ button to flash the entire page with the new byte values into device 
memory. 

Figure 16: BlueNRG-1 Flasher utility changing memory fields 

 

 

4.2.5 Using BlueNRG-1 Flasher utility with other boards 

The BlueNRG-1 Flasher – Utility automatically detects BlueNRG-1 evaluation boards like 
STEVAL-IDB007V1 and uses an auxiliary STM32 to (driven by the GUI) to reset the 
BlueNRG-1 and put it into bootloader mode. 

The application also works with custom boards providing simple UART access to the 
BlueNRG-1 device, but you must put the device in bootloader mode manually. Upon the 
selection of any non-STEVAL COM port, the following popup appears. 
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Figure 17: BlueNRG-1 Flasher utility ‘Comport Setting’ popup 

 

When this popup appears, set the BlueNRG-1 pin DIO7 high and reset the BlueNRG-1 
device (keeping the DIO7 high); the device should now be in bootloader mode. 

You can also set a preferred Baudrate for the UART in the popup window and then press 
OK to return to the GUI. 
 

 

Avoid resetting the device while using the BlueNRG-1 Flasher utility unless the 
Comport Setting popup is active. If the device is reset, you must toggle the COM 
port to use the Flasher utility again. 
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5 Programming with BlueNRG-1 system on chip 
The BlueNRG-1 Bluetooth low energy (BLE) stack is provided as a binary library. A set of 
APIs to control BLE functionality. Some callbacks are also provided for user applications to 
handle BLE stack events. The user is simply requested to link this binary library to his or 
her application and use the relevant APIs to access BLE functions and complete the stack 
event callbacks to manage responses according to application requirements. 

A set of software driver APIs is also included for accessing the BlueNRG-1 SoC peripherals 
and resources (ADC, GPIO, I²C, MFTX, Micro, RTC, SPI, SysTick, UART and WDG). 

The development kit software includes sample code demonstrating how to configure 
BluenRG-1 and use the device peripherals and BLE APIs and event callbacks. 
Documentation on the BLE APIs, callbacks, and peripheral drivers are provided in separate 
documents. 

5.1 Software directory structure 

The BlueNRG-DK software package files are organized in the following directories: 

 Application: containing BlueNRG-1 Navigator and Flasher PC applications. 

 Doc: with doxygen BLE APIs and events, BlueNRG-1 peripheral drivers, BLE demo 
applications, BlueNRG-1 Peripheral examples, BlueNRG-1 SDK and HAL driver 
documentation, DK release notes and license file. 

 Firmware: with prebuilt binary BLE and peripheral driver sample applications. 

 Library 

 Bluetooth LE: Bluetooth low energy stack binary library and all the definitions of 
stack APIs, stack events callbacks and constants. Over-the-air Bluetooth low 
energy firmware upgrade support. 

 BlueNRG1_Periph_Driver: BlueNRG-1 drivers for device peripherals (ADC, 
clock, DMA, Flash, GPIO, I²C, timers, RTC, SPI, UARR and watchdog). 

 CMSIS: BlueNRG-1 CMSIS files. 

 SDK_Eval_BlueNRG1: SDK drivers providing an API interface to the BlueNRG-1 
platform hardware resources (LEDs, buttons, sensors, I/O channel). 

 HAL: Hardware abstraction level APIs for abstracting certain BlueNRG-1 
hardware features (sleep modes, clock based on SysTick, etc.). 

 Project 

 BLE_Examples: Bluetooth low energy demonstration application including 
Headers, source files and EWARM, Keil and Atollic project files. 

 BlueNRG1_Periph_Examples: with sample applications for the BlueNRG-1 
peripherals and hardware resources, including Headers, source files and project 
files. 

 Utility: contains some utilities 
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6 BlueNRG-1 beacon demonstration application  
The BlueNRG-1 beacon demo is supported by the BlueNRG-1 development platform 
(STEVAL-IDB007V1). It demonstrates how to configure a BlueNRG-1 device to advertise 
specific manufacturing data and allow another BLE device to determine whether it is in 
BlueNRG-1 BLE beacon device range. 

6.1 BLE Beacon application setup  

This section describes how to configure a BlueNRG-1 device to act as a beacon device. 

6.1.1 Initialization  

The BlueNRG-1 BLE stack must be correctly initialized thus: 

aci_gatt_init(); 

aci_gap_init(GAP_PERIPHERAL_ROLE, 0, 0x08, &service_handle, &dev_name_char_handle, 
&appearance_char_handle); 

See the BlueNRG-1 BLE stack documentation for more information on these and following 
commands. 

6.1.2 Define advertising data  

The BLE Beacon application advertises the following manufacturing data: 

Table 5: BlueNRG-1 Beacon advertising manufacturing data 

Data field Description Notes 

Company identifier 
code 

SIG company identifier(1) Default is 0x0030 (STMicroelectronics) 

ID Beacon ID Fixed value 

Location UUID Beacons UUID 
Used to distinguish specific beacons from 
others 

Major number 
Identifier for a group of 
beacons 

Used to group a related set of beacons 

Minor number 
Identifier for a single 
beacon 

Used to identify a single beacon 

Tx Power 
2's complement of the Tx 
power 

Used to establish how far you are from 
device 

 

Notes: 
(1)available at: https://www.bluetooth.org/en-us/specification/assigned-numbers/company-identifiers 

 

6.1.3 Entering non-connectable mode  

The BLE Beacon device uses the GAP API command to enter non-connectable mode thus: 

aci_gap_set_discoverable(ADV_NONCONN_IND, 160, 160, PUBLIC_ADDR, 

                         NO_WHITE_LIST_USE,0, NULL, 0, NULL, 0, 0); 

To advertise the specific selected manufacturer data, the BLE Beacon application can use 
the following GAP APIs: 

/* Remove TX power level field from the advertising data: it is necessary     to 
have enough space for the beacon manufacturing data */ 

aci_gap_delete_ad_type(AD_TYPE_TX_POWER_LEVEL); 
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